
 

 

MXview User’s Guide 

Second Edition, September 2010 

www.moxa.com/product 

 

 

 2010 Moxa Inc. All rights reserved. 
Reproduction without permission is prohibited. 

http://www.moxa.com/product�


 

 

MXview User’s Guide 
The software described in this manual is furnished under a license agreement and may be used only in 

accordance with the terms of that agreement. 

Copyright Notice 
Copyright  2010 Moxa Inc. 

All rights reserved. 
Reproduction without permission is prohibited. 

Trademarks 
MOXA is a registered trademark of Moxa Inc. 

All other trademarks or registered marks in this manual belong to their respective manufacturers. 

Disclaimer 
Information in this document is subject to change without notice and does not represent a commitment on the 
part of Moxa. 

Moxa provides this document “as is,” without warranty of any kind, either expressed or implied, including, but 
not limited to, its particular purpose. Moxa reserves the right to make improvements and/or changes to this 
manual, or to the products and/or the programs described in this manual, at any time. 

Information provided in this manual is intended to be accurate and reliable. However, Moxa assumes no 
responsibility for its use or for any infringements on the rights of third parties that may result from its use. 

This product may include unintentional technical or typographical errors. Changes are periodically made to the 
information herein to correct such errors, and these changes are incorporated into new editions of the 
publication. 

 

Technical Support Contact Information 
www.moxa.com/support 

 

Moxa Americas: 
Toll-free: 1-888-669-2872 
Tel: +1-714-528-6777 
Fax: +1-714-528-6778 

Moxa China (Shanghai office): 
Toll-free: 800-820-5036 
Tel: +86-21-5258-9955 
Fax: +86-21-5258-5505 

Moxa Europe: 
Tel: +49-89-3 70 03 99-0 
Fax: +49-89-3 70 03 99-99 

Moxa Asia-Pacific: 
Tel: +886-2-8919-1230 
Fax: +886-2-8919-1231 

 

http://www.moxa.com/support�


 

 

Table of Contents 
 Chapter 1 Key Features .............................................................................................. 1-1 

Web-based Operation ........................................................................................................... 1-2 
Auto Discovery and Topology Visualization ........................................................................ 1-2 
Event Management ............................................................................................................... 1-2 
Configuration and Firmware Management ........................................................................... 1-2 
Traffic Monitoring ................................................................................................................ 1-2 

 Chapter 2 System Requirements and Supported Devices ...................................... 2-1 
System Requirements ........................................................................................................... 2-2 
Supported Devices ................................................................................................................ 2-2 

 Chapter 3 Installation and Migration ......................................................................... 3-1 
Installation Pocedure ............................................................................................................ 3-2 
Uninstallation ....................................................................................................................... 3-2 
Migration .............................................................................................................................. 3-2 
Version Upgrade ................................................................................................................... 3-2 

 Chapter 4 Getting Started .......................................................................................... 4-1 
MXview Server Startup ........................................................................................................ 4-2 
Login .................................................................................................................................... 4-2 
Account ................................................................................................................................ 4-3 
Auto Installation of Runtime Environment (Java Runtime Environment) ........................... 4-3 

 Chapter 5 Quick Start Using the Setup Wizard ........................................................ 5-1 
Step 1: Create Group ............................................................................................................ 5-2 

 Chapter 6 Dashboard Overview ................................................................................. 6-1 
Menu Bar .............................................................................................................................. 6-2 
Topology Map ...................................................................................................................... 6-3 
Device List ........................................................................................................................... 6-3 
Device Properties List .......................................................................................................... 6-4 
Recent Events List ................................................................................................................ 6-4 

 Chapter 7 Device Discovery and Polling .................................................................. 7-1 
Change Read Community String .......................................................................................... 7-1 
Scan Range ........................................................................................................................... 7-2 
Device Discovery ................................................................................................................. 7-3 

 Chapter 8 Topology Management ............................................................................. 8-1 
Two-layer Tree Structure ...................................................................................................... 8-1 
Auto Topology and Auto Layout .......................................................................................... 8-2 
Redundant Topologies .......................................................................................................... 8-4 
Port Trunking ........................................................................................................................ 8-4 
Adding a Link ....................................................................................................................... 8-5 
Delete a Link ........................................................................................................................ 8-6 
Delete a Device ..................................................................................................................... 8-6 
Navigation ............................................................................................................................ 8-8 
Background .......................................................................................................................... 8-8 
Export Topology ................................................................................................................... 8-9 

 
 



 

 

 Chapter 9 Event and Notification .............................................................................. 9-1 
Monitoring Methods ............................................................................................................. 9-1 

Monitoring via SNMP Trap Messages ......................................................................... 9-1 
Monitoring via Periodic Polling ................................................................................... 9-3 
Color Coding Indicates Problems ................................................................................. 9-3 

Event Recovery .................................................................................................................... 9-3 
Severity Level ....................................................................................................................... 9-4 
Recent Events ....................................................................................................................... 9-4 
Event History ........................................................................................................................ 9-5 
Notification ........................................................................................................................... 9-6 

Add an SMS Action ...................................................................................................... 9-6 
Add an Email Action .................................................................................................... 9-9 
Add a Sound ............................................................................................................... 9-10 
Add an External Program ........................................................................................... 9-11 

 Chapter 10 Traffic Reporting ..................................................................................... 10-1 
Checking the Trend ............................................................................................................. 10-1 
Threshold & Event Notification ......................................................................................... 10-2 

 Chapter 11 Device Management ................................................................................ 11-1 
Properties ............................................................................................................................. 11-1 
Changing Device Properties ................................................................................................ 11-2 
Web Console Login ............................................................................................................. 11-3 
Configuration Backup and Restoration (Moxa devices only) .............................................. 11-3 
Firmware upgrade ................................................................................................................ 11-3 
Refresh Status ...................................................................................................................... 11-3 

 Chapter 12 VLAN ......................................................................................................... 12-1 

 Chapter 13 MXview License ....................................................................................... 13-1 
Checking the License ......................................................................................................... 13-1 
License Upgrade ................................................................................................................. 13-2 

 Appendix A FAQ ............................................................................................................ A-1 

 Appendix B License ...................................................................................................... B-1 



 

 

11  
Chapter 1 Key Features 

Moxa MXview network management software gives you a convenient graphical representation of 
your Ethernet network, and allows you to configure, monitor, and troubleshoot Moxa networking 
devices. MXview provides an integrated management platform that can manage Moxa networking 
devices, such as Ethernet switches and wireless APs, and SNMP-enabled and ICMP-enabled 
devices installed on subnets. Network components that have been located by MXview can be 
managed via web browsers from both local and remote sites—anytime, anywhere. 

The following topics are covered in this chapter: 

 Web-based Operation 
 Auto Discovery and Topology Visualization 
 Event Management 
 Configuration and Firmware Management 
 Traffic Monitoring 
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Web-based Operation 
MXview uses the client-server model. You will need to install the MXview server on a Windows 
computer connected to the network(s) that are to be managed. After installing MXview, the 
network can be managed with Internet Explorer or Firefox, without installing additional software. 

Auto Discovery and Topology Visualization 
Within the scan range, MXview locates networking devices with SNMP or ICMP services enabled. 
MXview can collect topology information from devices with LLDP capability and draw the 
topology of the network, which shows physical connections. 

Event Management 
For troubleshooting purposes, MXview logs events that match preset conditions, such as link 
up/down, device unreachable, or traffic overloading. The most recent events will show up on the 
dashboard. Devices and links that generate events will be highlighted with different colors. When 
an event occurs, users can be notified in a number of different ways, including SMS, email, popup 
window, sound, or external program. 

Configuration and Firmware Management 
MXview provides an interface for managing Moxa networking devices from a central location. 
Users can remotely backup or update configuration files, and upgrade firmware. 

Traffic Monitoring 
MXview can log the network traffic of network devices that have been discovered. 
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Chapter 2 System Requirements 
and Supported Devices 

The following topics are covered in this chapter: 

 System Requirements 
 Supported Devices 
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System Requirements 
The computer that MXview is installed on must satisfy the following system requirements: 

CPU:    Intel Core 2 Duo, 2.4 GHz or faster. 

RAM:    1 GB or more 

Hard Disk Space:  10 GB or more 

Operating System:  Windows XP Professional/7/Server 2008 

Browser:    IE 6/7/8, Firefox 3 with JRE 6 

User Interface Language: English or Simplified Chinese 

Supported Devices 
• The Moxa networking devices listed in the “Required Firmware Version Table” below can be 

used with MXview, provided the device is running the firmware version listed in the table. 
These Moxa networking devices support a wide range of functions, such as network status, 
traffic log, and configuration / firmware file management (see the “Function Support Table” 
below).  

• For other SNMP-enabled devices, MXview supports standard management functions, such as 
link up, link down, and SNMP MIBII information. 

• MXview can only monitor the connectivity of devices that support ICMP. 

Function Support Table 

 Moxa Device Non-Moxa Device 

Managed switch 
supportive 
firmware (table 
below) 

1. Managed 
switch with old 
firmware 

SNMP device ICMP device 
2. Other SNMP 
devices 

Auto Topology  – – – 

Device Recognition  – – – 

Active Event Notification  – – – 

Configuration/Firmware 
Management  – – – 

Traffic Report     – 

Passive Event Notification     

Availability Check     
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Required Firmware Version Table 

Model Name Required Firmware Version 

EDS-400A 2.6 or higher 
EDS-500A 2.6 or higher 
EDS-G509 2.6 or higher 
EDS-P510 2.6 or higher 
EDS-600 2.6 or higher 
EDS-728 2.6 or higher 
EDS-828 2.6 or higher 
IKS-6726 2.6 or higher 
PT-7710 1.2 or higher 
PT-7728 2.6 or higher 
PT-7828 2.6 or higher 
PT-G7509 1.1 or higher 
TN-5508/TN-5510 1.1 or higher 
TN-5516/TN-5518 1.2 or higher 

Additional model names will be added. Please check Moxa’s website for the 
most up-to-update information. 
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Chapter 3 Installation and Migration 

The following topics are covered in this chapter: 

 Installation Pocedure 
 Uninstallation 
 Migration 
 Version Upgrade 
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Installation Pocedure 
1. Execute the installation program or insert the auto-run CD. 

2. During the installation, you can choose the directory in which MXview will be installed and 
the default language, or leave the settings at the default values. 

3. For the commercial version, you will be asked to enter the license key; input the character 
string printed on the cover of the CD. 

4. After the installation is complete, shortcuts for launching the MXview server will be created 
on the desktop and in the start menu. 

Uninstallation 
1. Select Start  Control Panel, and then select Add or Remove Programs. 

2. Select MXview 

3. Select Remove 

You can also uninstall the software by selecting  
Start  All Programs  Moxa  MXview  Uninstall MXview. 

Migration 
To migrate the software from one computer to another, first use Project Export to save the 
system’s current device list and topology to a file, and then use Project  Import to transfer the 
system to another computer. 

Version Upgrade 
To upgrade the software to a new version, first use Project -> Export to save the system's current 
device list and topology to a file. Then, install the new version. Finally, use Project -> Import to 
upgrade the system to the new version. 
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Chapter 4 Getting Started 

MXview is implemented as a web server to realize remote management through a single portal. 
The following figure illustrates the operational model. 

 
The MXview server runs in the background on a Windows PC and communicates with network 
devices using SNMP Plus, a Moxa proprietary protocol that periodically polls specific MIB data 
and stores data in a local database. 

The MXview client uses web browsers to provide a uniform web interface that enables network 
operators to access and operate over an intranet or the Internet. 

 

This chapter covers the following topics: 

 MXview Server Startup 
 Login 
 Account 
 Auto Installation of Runtime Environment (Java Runtime Environment) 
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MXview Server Startup 
To start the MXview server, first double-click the MXview desktop shortcut. When the MXview 
window (shown below) pops up, configure the listening port of the server (or leave it at the default 
value of 80) and examine the runtime information. The server will launch when you click Start. 

Clicking Launch Client will start the MXview client on the local computer. To learn how to use 
the MXview client remotely, refer to the Login section below. 

 

Login 
To launch the MXview client, open a web browser and input the MXview server’s IP address or 
domain name in the address field. Note that if the server’s listening port changes, you will need to 
input the IP address as follows: http://192.168.1.250:8080. If you are using the server computer as 
the client, you may also click Launch Client on the control panel. The default account is admin 
with no password. 

 
Note: At most 3 users can log in to the system at the same time. 
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Account 
There are 2 accounts: admin and guest. The admin account possesses the privileges to change 
configurations in MXview, such as topology and scan range. The guest account is a read-only 
account. By default, the password of both accounts is empty, which can be changed in Preferences. 

Auto Installation of Runtime Environment (Java Runtime 
Environment) 

The MXview client must run in a JRE 6 environment. For IE users who do not have the 
appropriate version of JRE, installation of the update will start automatically. 

If you are using a browser other than IE, you will need to download JRE 6 from Java’s official 
website (http://java.sun.com/javase/downloads/index.jsp) and then install it on your computer. 
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Chapter 5 Quick Start Using the Setup Wizard 

MXview provides a Setup Wizard that can be used to quickly determine the network topology and 
handle basic configuration tasks. The wizard will launch automatically when the software does not 
contain any nodes. To launch the Setup Wizard manually, select Project  Wizard. You should 
see the following window: 

 
 

The wizard will guide you through four basic steps, described below. 
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Step 1: Create Group 
Devices scanned by MXview can be organized into a two-layer tree structure. Before finding 
devices, groups need to be created. Root is the only default group. All other created groups are 
placed under the next level of Root. 
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Step 2: Configure the SNMP Community String 
MXview uses SNMP to collect device information. The default SNMP configurations are:  

 Version: v1 

 Read community string: public 

 Write community string: private 

If necessary, update this information at this time: 
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Step 3: Add the networks you want to scan 
MXview’s operation is based on IP (Internet Protocol). Other devices in the scan range that use IP 
to operate will be located and monitored. 

 
Note: A device’s IP address must be configured properly before it can be managed by 
MXview. 
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At this point, MXview will enter the discovery stage. The time needed to complete this stage 
depends on the size of the scan range. Click Cancel at this point to exit the wizard; however, the 
configurations entered previously will be saved and the discovery process will continue running in 
the background. 

 

Step 4: Draw the topology 
After all devices have been located, MXview will be able to draw the topology for LLDP devices. 

 

 
For devices without LLDP functionality, the topology can be drawn manually after the wizard is 
finished. 
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After all devices have been discovered and the topology has been created, click Next to continue 
to the next step. 

 
If necessary, use the slider shown in the following figure to adjust the resolution. 
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Step 5: Set the SNMP Trap Server to get events in real time 
To enable real-time event generation, the MXview server’s IP address needs to be configured as a 
trap server. To do this, enter the IP address of the MXview Server and then click Set to activate the 
change. 

If this step is skipped, devices can still be monitored by polling periodically, although a time 
latency will be introduced. 

 
 

After this point, MXview initialization is complete. 
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Chapter 6 Dashboard Overview 

The Dashboard should appear when you log in to MXview. When using MXview, you will spend 
most of your time working from the Dashboard, which is divided into the following sections. 

 
 Menu Bar 

 Topology Map 

 Device List 

 Device Properties List 

 Recent Events List 
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Menu Bar 
All operations can be accessed from the following menu bar items: 

Project 
Use the Project menu to export data and configurations of the monitored networks to a local file, 
or import a project file to create monitored networks on the fly. 

View 
Use the View menu to change the appearance of the Topology Map. For example, you can adjust 
the resolution or create a topology map. 

Device 
Use the Device menu to configure or examine the properties of objects. 

Link 
Use the Link menu to delete a link or get traffic reports. 

Information 
Use the Information menu to examine network-wide properties. 

Event 
Use the Event menu to examine events. 

Tools 
Use the Tools menu to launch additional services or programs, such as Moxa IP Configurator. 

Help 
Use the Help menu to view license information or information about MXview. 
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Topology Map 
The Topology Map displays connection relationships of monitored devices. For devices with 
LLDP capability, the connections can be drawn automatically. For other devices, connection links 
can be drawn manually. 

 
 

Device List 
The Device List shows the Topology Map structure in tree format. Note that link information is 
not shown. Type all or part of a device name in the “Search Devices” input box to only show 
devices whose names contain that keyword (for example, type “EDS” to show all EDS devices, or 
type “EDS-G509” to show all EDS-G509 switches in the network. 
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Device Properties List 
The Device Properties list shows the properties of the device that is currently selected. 

 

Recent Events List 
This list shows events that have occurred most recently. 

Event Count lists the total number of events of different types, with different event types 
identified by different colored rectangles (e.g., red, yellow, and green, as shown in the following 
screen shot). 

All Events is the shortcut of the menu item Event  All. When you click All Events, a window 
will pop up showing all events. 
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Chapter 7 Device Discovery and Polling 

Devices in the assigned scan range can be discovered via SNMP and ICMP protocols. After a 
device is discovered, MXview will use SNMP and ICMP to poll the device periodically. To 
configure this function properly, you will need to know the following information: 

1. The IP addresses of the devices on the network. 

2. The Read community name assigned to the devices on the network. 

Change Read Community String 
The default Read community string that is used to discover devices is public. Take the following 
steps to change the value: 

1. Select Project  Preferences  SNMP Configuration. 

2. Enter the new Read community string. 
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Scan Range 
You can assign multiple scan networks, with each network defined by a starting IP address and an 
ending IP address. MXview will discover all active devices that belong to the scan networks. 

Take the following steps to add a scan network: 

1. Select Project  Scan Range. 

 
2. Click Add Network. 
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3. Input the starting and ending IP addresses of the range, and then click OK. 

4. Click OK & Discovery to start discovery. 

Note: Device discovery will require more time for larger networks. For this reason, if 
possible you should avoid defining large scan ranges. 

 

Deleting a scan network will remove the monitored devices that belong to the network. Take the 
following steps to delete a scan network: 

1. Select Project  Scan Range 

2. Select a row in the table Scan Range 

3. Click Delete Network 

4. Click OK to activate the change 

 

Modifying a scan network will remove devices that do not belong to the new network, and 
discover new devices within the new network. Take the following steps to modify a scan network: 

1. Select Project  Scan Range 

2. Select a row in the table Scan Range 

3. Click Modify Network 

4. Modify the starting and ending IP address of the range, and then click OK. 

5. Click OK to activate the change. 

Deselecting the Active checkbox of a scanned network will stop device discovery for that network. 
Previously discovered devices will continue to be monitored, with the current status shown on the 
topology map. 

Device Discovery 
MXview will use SNMP and ICMP to discover devices within the scan ranges. When a Moxa 
device has been located, MXview will use an actual image of the device, such as the one shown 
below, to indicate the device’s location in the network. 

 
MXview will also list detailed properties and configuration parameters, including the following: 

• MAC address 
• Model name 
• IP address 
• Netmask 
• Gateway 
• Trap server address 
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• Auto IP configuration 
• Type of redundancy protocol 
• Role in redundancy protocol 
• Status and properties of the port 
• Status of the power 
• Status and version of the SNMP protocol 

MXview will use one of the following graphics to indicate devices: 

 Moxa devices with SNMP enabled. 

 

 Third party devices with SNMP enabled. 

 

 Third party devices with ICMP enabled. 

 
 

The IP address and location name of the discovered device will be shown under the image of the 
device. Take the following steps to change the location name: 

1. Select the device 

2. Select Device Maintenance Configure IP & SNMP 

3. Select the Basic tab and then enter the new location name. 

MXview will run conduct device discovery periodically to find new devices in the scan ranges. 
You may also use the following steps to conduct device discovery manually: 

1. Select project  Scan Range 

2. Click OK & Run Discovery 

 

Discovered devices will be polled periodically by ICMP and SNMP. This is done for the following 
reasons: 

1. To monitor the availability of devices. 

2. To update properties and configuration parameters of devices. 

3. To update traffic information, such as utilization. 
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Chapter 8 Topology Management 

The Topology Map is the core of MXview, and can be used to complete most actions. The 
Topology Map shows a graphical representation of the devices in your networks, and can be used 
to do the following: 

• Display a graphical representation of a real network. 

• Show connecting relationships between devices. 

• Indicate the status of devices and links. 

Two-layer Tree Structure 
The Topology Map can be organized as a two-layer tree structure. It helps users manage a large 
number of nodes, up to 1,000, on the computer screen. For example, users can move nodes of the 
same subnet or location into the same group. Root, which is the only one group at the first layer, 
exists by default and cannot be deleted. Groups created by users are in the second layer under Root. 
Devices can be moved between groups. MXview uses an icon to indicate user-defined groups: 
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The first layer will be shown as: 

 
The second layer will be shown as: 

 
The map is represented as a tabbed window, in which each tab is a group. Double clicking a group 
icon in Root will open the corresponding tab. 

Auto Topology and Auto Layout 
For devices with LLDP functionality, MXview can draw the physical topology map, down to the 
port level of the devices. MXview can do the following two tasks automatically: (1) Create a new 
topology, and (2) Update the existing topology. 

Creating a new topology deletes all links, requests LLDP information from devices, and draws 
topology maps based on the gathered information. 

1. Select View  Auto Topology 
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2. Select New Topology 

3. Click OK 

 
Note: Links drawn manually will be also deleted by this action. 

Updating the existing topology adds new links and updates existing links, but does not change the 
status of links that are indicated as having been disconnected or links that were drawn manually. 

1. Select View  Auto Topology 

2. Select Update Topology 

3. Click OK 

 
The following figure shows an example of a topology map: 
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Redundant Topologies 
Redundant topologies have at least one backup link, which will be indicated with a dashed line: 

 
For devices that play a particular role in the topology, MXview will label the devices by displaying 
the roles above the images of the devices. Backup links will be indicated with dotted lines. 

• RSTP has a Root 

• Turbo Ring has a Master 

• Turbo Chain has a Head and a Tail 

Note: Only auto topology can draw dashed lines for redundancy links. Manually drawn 
redundant links will appear as solid lines. 

Port Trunking 
Port trunking, also called link aggregation, involves grouping links into a link aggregation group. 
Trunking links will be indicated with thick, solid lines. 

 
Note: Only auto topology can draw thick lines for trunking links. Manually drawn trunking 
links will appear as solid lines. 

Note: For trunked link, check “Device Properties” to get the port number corresponding to 
the trunking group. 
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Adding a Link 
Use one of the following two options to connect two devices with a link in a topology map: 

1. Right click on a device and then select Add Link. 

2. Click on a device to select it and then click Link  Add Link on the menu bar. 

 
3. Enter the ports and IP addresses corresponding to the link. 

 
Note: Trunking and redundancy links added manually will appear as solid lines. 

Note: Port numbers must be numeric and entered correctly to obtain the correct traffic 
information. 

Note: For modular switches, a port number depends on the chassis to which the port belongs, 
but not on how many modules are inserted. For switches such as the PT-7828, the first 
module’s port numbers are from 1 to 8, the second module’s port numbers are from 9 to 16, 
and so on. The port number depends only on which slot the module is in; in other words, the 
port number is the same regardless of whether other slots are empty or occupied. 
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Delete a Link 
Use the following steps to remove a link in the topology map: 

1. Select the link. 

2. Right-click the link and select Delete Link, or select Link  Delete Link. 

 
Note: Deleting a link will delete a link from the topology map, but it will not affect the actual 
network configuration. 

Delete a Device 
You can delete devices from the topology map. After a device is deleted, it will be removed from 
the topology map and scan range, and the device would not be polled or located when conduction 
device discovery. Take the following steps to delete a device: 

1. Select the device 

2. Right-click the device 

3. Select Delete Device 
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Deleted devices will be recorded in Project  Scan Range. 

 
You may recover devices that have been deleted. Once recovered, the devices will be polled and 
located when conducting device discovery Take the following steps to recover deleted devices: 

1. Select Project  Scan Range 

2. Select a row in table Deleted Devices 

3. Click Recover and then click OK 
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Navigation 
Mini map is a frame with a slider for adjusting the resolution. This function helps users zoom in to 
enlarge devices or zoom out to view more devices on the screen. 

 

Background 
You may insert a background image into the topology map to provide additional references, such 
as geographical information or deployment layout. 

Take the following steps to insert or change a background image: 

1. Select View  Background  Set 

2. Choose an image from the local file system. 

Take the following steps to delete the background image from the topology map: 

Select View  Background  Delete 
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Export Topology 
The topology map can be exported as a JPEG image. Take the following steps to export the 
topology map: 

1. Select View  Export Topology 

2. Choose the location to which the image is saved. 

OPC Tag Generation 
MXview can generate OPC 2.0 compliant tags for device and link properties. Then, OPC clients 
such as SCADA systems can access and use these tags.  

1. Select Tools -> OPC Server 

2. Click Start. 

Currently, information that MXview can prepare as tags include: a device's IP address, MAC 
address, description, location and status, which are labeled beginning with D_, and a link's 
corresponding IP addresses and ports, which are labeled beginning with L_. 
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Chapter 9 Event and Notification 

Monitoring Methods 
Monitoring can be conducted using SNMP trap messages, periodic polling, or color coding, as 
described in the following subsections. 

Monitoring via SNMP Trap Messages 
By using the MXview server as a trap destination of a device, events associated with the device 
will be sent to the server in real time, and can be seen by remote clients. 

Take the following steps to set the trap destination of all devices: 

1. Select Network  Set SNMP to All. 

2. Enter the IP address of the MXview server and the community string. 
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Take the following steps to set the trap destination of one device: 

1. Select Device Maintenance Configure IP & Trap 

2. Choose tab Trap Server 

3. Enter the IP address of the MXview server and community string 

 
The event types include port link up/down, power on/off, topology change, and configuration 
change. 

Each discovered device will be monitored automatically by trap once its trap destination is 
configured correctly. 

 

 

 

 

 

 

 

 



MXview User’s Guide Event and Notification 
 

 9-3 

Monitoring via Periodic Polling 
After a device has been discovered, MXview polls the status of the device’s active port 
periodically. Keep in mind that since trap messages are transmitted by UDP protocol, there is no 
absolute guarantee that the messages will be received. What periodic polling does is provide a 
higher level of reliability for monitoring devices. 

With periodic polling, MXview can passively monitor the availability of a device’s SNMP service, 
bandwidth utilization, error packet rate, and collision rate. Separate thresholds can be used for 
bandwidth utilization, error packet rate, and collision rate, respectively. When any of these 
thresholds are surpassed, the device will indicate that an event has occurred. 

Color Coding Indicates Problems 
When a link causes a warning to be issued or a critical event occurs (link down, for example), the 
color of the corresponding link line will change: 

 
When a device causes a warning or a critical event occurs (device failure, for example), the errant 
device will be indicated with a box with red borders. 

 
In addition, the events will be added to the recent events list. 

 
 

Event Recovery 
Events will be recovered automatically when condition that caused the event is resolved. 
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Severity Level 
Events can be set to one of three severity levels: critical, warning, or information. The conditions 
that give rise to a particular severity level can be configured by the user. To configure the severity 
levels, select Project  Preferences  Events, and then modify the settings. 

 

Recent Events 
MXview shows recent events at the bottom of the Dashboard. 
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Event History 
To show the event history of all devices, select Event  All from the menu bar. 

To show the event history of a single device, click the device to select it, and then select Event  
Device from the menu bar. 

 
The table contains 40 entries on a page. Use the page controls at the bottom to navigate between 
pages. 

 
You can sort the table by clicking the header cells. 

 
To filter the table, use the selection box of the header cell and select a value. 

 
Note: The sorting and filtering functions only affect table entries currently showing on the 
screen. They do not regenerate the entire table. This remains true even if there are currently 
fewer than 40 entries showing. 
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You can export all events to a CSV file, or delete all events from the database. 

 

Notification 
You can associate an action, such as send a text message, send an email, make a sound, or run an 
external program, with a combination of a type of event, a source IP address, and a severity level.  

Add an SMS Action 
To send an SMS notification, first connect an SMS modem, such as the Moxa Oncell, to an 
MXview Server COM port. Take the following steps to configure SMS notification: 

1. Select Event  Notification 
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2. Click Email Server / SMS COM Port 

 
 

3. Select the COM port to which the modem is connected and then click OK. 

4. Click New in the Action List 

5. Select SMS as the type, type the phone number, give the action a name, and then click OK. 
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6. Click New in the Notification List. 

7. Select the action just added and the corresponding event type, source IP. 

 
8. Click OK. 
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Add an Email Action 
Take the following steps to configure the Email (SMTP) server to send an Email notification: 

1. Select Event  Notification 

2. Click Email Server / SMS COM Port 

3. Input the SMTP server that can send an e-mail and the user name and password needed to log 
in to the server, and then click OK. 

4. Click New in the Action List. 

5. Select Email as the type, type the email address, give the action a name, and then click OK. 

 
6. Click New in the Notification List. 

7. Select the action just added and the corresponding event type, source IP. 

8. Click OK. 
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Add a Sound 
When a sound notification is triggered, the MXview server will play the associated sound file. The 
sound will play repeatedly until some stops it manually. Take the following steps to add a sound: 

1. Select Event  Notification 

2. Click New in Action List. 

3. Select Sound as the type, select a file from the local computer, give the action a name, and 
then click OK. The file will be uploaded to the MXview server. 

 
4. Click New in the Notification List. 

5. Select the action just added and the corresponding event type, source IP. 

6. Click OK. 

 

When a associated event occurs, the sound file will be played and a window will pop up: 

 
The sound will not stop until someone clicks OK. 

Note: When more than one event occurs, the sound file corresponding to the first event will 
be played first, and the sounds corresponding to subsequent events will be queued. After first 
sound is stopped, the next sound in the queue will be played. 

Note: Only the wav format is supported. 
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Add an External Program 
When a program notification is triggered, the MXview server will execute the associated program. 
Take the following steps to add a program:  

1. Select Event  Notification. 

2. Click New in the Action List. 

3. Select Program as the type, select a file from the local computer, give the action a name, and 
then click OK. The file will be uploaded to the MXview server.  

4. Click New in the Notification List.  

5. Select the action just added, the corresponding event type, and the source IP.  

6. Click OK.  

When an associated event occurs, the program file will be executed. 
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Chapter 10 Traffic Reporting 

MXview compiles traffic statistics for devices running on the network. The statistics are used to 
create reports that show trend utilization and performance of the device interfaces. Statistics are 
complied for the following items: 

 Traffic utilization (%) 

 Error packet rate (%) 

 Collision rate (%)  

Events will be generated when one of these items is above or below the corresponding thresholds. 

Checking the Trend 
Before MXview can collect traffic statistics between two devices, a link must be created (see the 
section “Adding a Link” in chapter 8 to see how to add a link). 

The graph shows data for a particular day. The x-axis unit is hours. To check the graph for a 
different date, use Select Date. 
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Threshold & Event Notification 
There are 4 conditions related to traffic that can trigger events: 

1. Bandwidth utilization is over a threshold. 

2. Bandwidth utilization is under a threshold. 

3. Packet error rate is over a threshold. 

4. Packet collision rate is over a threshold. 

Since a link is bidirectional, the event will be triggered when one of the directions satisfies any 
event’s trigger condition. 

To learn how to change the threshold, refer to Monitoring Methods  Color Coding Indicates 
Problems  Severity Level in Chapter 9. 

To learn how to configure notification, refer to Monitoring Methods  Color Coding Indicates 
Problems  Notification in Chapter 9. 
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Chapter 11 Device Management 

Properties 
You may select a device and check its properties in Device Properties. Properties that are listed 
include model name, MAC address, IP address, netmask, gateway, port type and status, power 
status, redundancy protocol, SNMP, and ICMP availability. 
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Changing Device Properties 
Take the following steps to change a device’s location, name, contact, IP, netmask, gateway, trap 
server, and SNMP configuration: 

1. Select a device. 

2. Select Device  Maintenance  Configure IP & Trap. 

Click the Basic tab to change the name, location, and contact information for a device. The new 
values will be written to the device’s firmware. 

Click the IP Configuration tab to change a device’s IP address, netmask, gateway, DNS server, 
and method of obtaining the IP. 

Click the Trap Server tab to change IP addresses and community strings of trap servers. Moxa 
switches can send trap messages to at most 2 trap servers. 

Click the SNMP Configuration tab to choose the SNMP version and enter the corresponding 
parameters. 
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Web Console Login 
To log in to the device’s web console, select Device  console. 

Note: For IE6, MXview will open the console in the window of the MXview Client. 

Configuration Backup and Restoration (Moxa devices only) 
Take the following steps to back up a device’s configuration file to a local computer: 

1. Select Device  Maintenance  Configuration  Load from Device. 

2. Choose the location where you would like to save the file. 

 

Take the following steps to restore a device’s configuration file:  

1. Select Device  Configuration  Load to Device. 

 
2. Choose the file and click OK. 

Firmware upgrade 
To up upgrade a device’s firmware, select Device  Firmware Upgrade. The firmware will be 
uploaded to and installed on the device. 

 
Note: After the firmware has been installed successfully, the device will restart. This action could 
take a few seconds. 

Refresh Status 
Since some device data is collected by polling, there may be a time delay for some data. To refresh 
a device to get its updated status, select Device  Refresh. 
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Chapter 12 VLAN 

Moxa switches support 802.1Q tagged VLAN and port-based VLAN. MXview collects each 
device’s VLAN configuration and integrates the configurations into one table to provide a 
network-wide view. To view the table, select Network  VLAN. 
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Chapter 13 MXview License 

MXview is available in different versions, which the different versions supporting different 
numbers of nodes. For example, if your version of MXview supports 250 nodes, then during 
device discovery MXview will only recognize up to 250 nodes. MXview will stop the device 
discovery procedure once it reaches the 250-node limit. 

The MXview license that you purchase specifies the node limit for that version of MXview. To 
increase the node limit, you can purchase license upgrade and import the upgrade into MXview. 

Checking the License 
The number of currently managed nodes and the node limit is shown in the Status Bar on the 
Dashboard. 

 
 

To check the details, select Help  License. 
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License Upgrade 
To increase the node limit of your MXview, you need upgrade the license. 

1. Select Help  License. 

2. Click Add License. 

 
3. Find the license label in the software package, which is shown as: 

 
4. Enter the key of the new license and click OK. 

 
5. Restart the MXview client. 
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Appendix A FAQ 

Why do events show up late? 
Make sure you have configured your switches’ SNMP trap server to the MXview server’s IP 
address, since doing so will provide real-time responses to events. Otherwise, MXview will collect 
information periodically. 

Why can’t I discover all of the devices on my network? 
Please check the following: 

1. Make sure your license supports a sufficient number of nodes. 

2. Make sure your scan range includes all of the IP addresses of devices on your network. 

3. Make sure your switches do not go into protection mode because they consider MXview 
packets to be part of a broadcast storm. 

Why does one device have more than one icon? 
MXview identifies devices by IP address. For this reason, if one device has more than one IP 
address within the scan range, the device will be viewed as multiple devices. 

Will deleting a link in MXview cause the link to be disconnected in the real 
network? 

No. The topology map shows the status of the real network, but cannot be used to configure the 
real network. 

After a link in a ring is disconnected, why does it take a few seconds for 
the redundant link to become solid in the topology map? 

MXview uses polling to determine if redundant links have become non-redundant. For this reason, 
the topology map will not be updated until all devices in the network have been polled. In addition, 
since it takes a finite amount of time to transmit the network status to the MXview server, it will 
take at least that amount of time for the topology map to be updated. 
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Appendix B License 

License (Net-SNMP) 
Various copyrights apply to this package, listed in several separate sections below.  

Please carefully review all sections of the license information. 

 

---- Part 1: CMU/UCD copyright notice: (BSD like) ----- 

 

Copyright 1989, 1991, 1992 by Carnegie Mellon University 

 

Derivative Work - 1996, 1998-2000 

Copyright 1996, 1998-2000. The Regents of the University of California 

 

All Rights Reserved 

 

Permission to use, copy, modify and distribute this software and its documentation for any purpose 
and without fee is hereby granted, provided that the above copyright notice appears in all copies 
and that both that copyright notice and this permission notice appear in supporting documentation, 
and that the name of CMU and The Regents of the University of California not be used in 
advertising or publicity pertaining to distribution of the software without specific written 
permission. 

 

CMU AND THE REGENTS OF THE UNIVERSITY OF CALIFORNIA DISCLAIM ALL 
WARRANTIES WITH REGARD TO THIS SOFTWARE, INCLUDING ALL IMPLIED 
WARRANTIES OF MERCHANTABILITY AND FITNESS. IN NO EVENT SHALL CMU OR 
THE REGENTS OF THE UNIVERSITY OF CALIFORNIA BE LIABLE FOR ANY SPECIAL, 
INDIRECT OR CONSEQUENTIAL DAMAGES OR ANY DAMAGES WHATSOEVER 
RESULTING FROM THE LOSS OF USE, DATA OR PROFITS, WHETHER IN AN ACTION 
OF CONTRACT, NEGLIGENCE OR OTHER TORTIOUS ACTION, ARISING OUT OF OR IN 
CONNECTION WITH THE USE OR PERFORMANCE OF THIS SOFTWARE. 
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---- Part 2: Networks Associates Technology, Inc copyright notice (BSD) ----- 

 

Copyright (c) 2001-2003, Networks Associates Technology, Inc 

All rights reserved. 

 

Redistribution and use in source and binary forms, with or without modification, are permitted 
provided that the following conditions are met: 

 

* Redistributions of source code must retain the above copyright notice, this list of conditions and 
the following disclaimer. 

 

* Redistributions in binary form must reproduce the above copyright notice, this list of conditions 
and the following disclaimer in the documentation and/or other materials provided with the 
distribution. 

 

* Neither the name of the Networks Associates Technology, Inc nor the names of its contributors 
may be used to endorse or promote products derived from this software without specific prior 
written permission. 

 

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS 
“AS IS”' AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT 
LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR 
A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT 
HOLDERS OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, 
SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT 
LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, 
DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY 
THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT 
(INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE 
OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE. 

 

---- Part 3: Cambridge Broadband Ltd. copyright notice (BSD) ----- 

 

Portions of this code are copyright (c) 2001-2003, Cambridge Broadband Ltd. 

All rights reserved. 

 

Redistribution and use in source and binary forms, with or without modification, are permitted 
provided that the following conditions are met: 

 

* Redistributions of source code must retain the above copyright notice, this list of conditions and 
the following disclaimer. 
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* Redistributions in binary form must reproduce the above copyright notice, this list of conditions 
and the following disclaimer in the documentation and/or other materials provided with the 
distribution. 

 

* The name of Cambridge Broadband Ltd. may not be used to endorse or promote products 
derived from this software without specific prior written permission. 

 

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDER “AS IS” AND ANY 
EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE 
IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR 
PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT HOLDER BE 
LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR 
CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF 
SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS 
INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER 
IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR 
OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF 
ADVISED OF THE POSSIBILITY OF SUCH DAMAGE. 

 

---- Part 4: Sun Microsystems, Inc. copyright notice (BSD) ----- 

 

Copyright © 2003 Sun Microsystems, Inc., 4150 Network Circle, Santa Clara,  

California 95054, U.S.A. All rights reserved. 

 

Use is subject to license terms below. 

This distribution may include materials developed by third parties. 

Sun, Sun Microsystems, the Sun logo and Solaris are trademarks or registered trademarks of Sun 
Microsystems, Inc. in the U.S. and other countries. 

Redistribution and use in source and binary forms, with or without modification, are permitted 
provided that the following conditions are met: 

* Redistributions of source code must retain the above copyright notice, this list of conditions and 
the following disclaimer. 

 

* Redistributions in binary form must reproduce the above copyright notice, this list of conditions 
and the following disclaimer in the documentation and/or other materials provided with the 
distribution. 

 

* Neither the name of the Sun Microsystems, Inc. nor the names of its contributors may be used to 
endorse or promote products derived from this software without specific prior written permission. 

 

 

 





MXview User’s Guide License 
 

 B-5 

---- Part 6: Cisco/BUPTNIC copyright notice (BSD) ----- 

 

Copyright (c) 2004, Cisco, Inc and Information Network 

Center of Beijing University of Posts and Telecommunications. 

All rights reserved. 

 

Redistribution and use in source and binary forms, with or without modification, are permitted 
provided that the following conditions are met: 

 

* Redistributions of source code must retain the above copyright notice, this list of conditions and 
the following disclaimer. 

 

* Redistributions in binary form must reproduce the above copyright notice, this list of conditions 
and the following disclaimer in the documentation and/or other materials provided with the 
distribution. 

 

* Neither the name of Cisco, Inc, Beijing University of Posts and Telecommunications, nor the 
names of their contributors may be used to endorse or promote products derived from this software 
without specific prior written permission. 

 

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS 
“AS IS” AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT 
LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR 
A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT 
HOLDERS OR 

CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, 
EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, 
PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR 
PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY 
OF LIABILITY, 

WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE 
OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN 
IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE. 
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---- Part 7: Fabasoft R&D Software GmbH & Co KG copyright notice (BSD) ----- 

 

Copyright (c) Fabasoft R&D Software GmbH & Co KG, 2003 

oss@fabasoft.com 

Author: Bernhard Penz  

 

Redistribution and use in source and binary forms, with or without modification, are permitted 
provided that the following conditions are met: 

 

* Redistributions of source code must retain the above copyright notice, this list of conditions and 
the following disclaimer. 

 

* Redistributions in binary form must reproduce the above copyright notice, this list of conditions 
and the following disclaimer in the documentation and/or other materials provided with the 
distribution. 

 

* The name of Fabasoft R&D Software GmbH & Co KG or any of its subsidiaries, brand or 
product names may not be used to endorse or promote products derived from this software without 
specific prior written permission. 

 

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDER “AS IS” AND ANY 
EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE 
IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR 
PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT HOLDER BE 
LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR 
CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF 
SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS 
INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, 

WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE 
OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN 
IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE. 
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---- Part 8: Apple Inc. copyright notice (BSD) ----- 

 

Copyright (c) 2007 Apple Inc. All rights reserved. 

 

Redistribution and use in source and binary forms, with or without modification, are permitted 
provided that the following conditions are met: 

1. Redistributions of source code must retain the above copyright notice, this list of conditions 
and the following disclaimer. 

2. Redistributions in binary form must reproduce the above copyright notice, this list of 
conditions and the following disclaimer in the documentation and/or other materials provided 
with the distribution. 

3. Neither the name of Apple Inc. (“Apple”) nor the names of its contributors may be used to 
endorse or promote products derived from this software without specific prior written 
permission. 

 

THIS SOFTWARE IS PROVIDED BY APPLE AND ITS CONTRIBUTORS “AS IS” AND ANY 
EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE 
IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR 
PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL APPLE OR ITS CONTRIBUTORS BE 
LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR 
CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF 
SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS 
INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER 
IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR 
OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF 
ADVISED OF THE POSSIBILITY OF SUCH DAMAGE. 

 

---- Part 9: ScienceLogic, LLC copyright notice (BSD) ----- 

 

Copyright (c) 2009, ScienceLogic, LLC 

All rights reserved. 

 

Redistribution and use in source and binary forms, with or without modification, are permitted 
provided that the following conditions are met: 

 

* Redistributions of source code must retain the above copyright notice, this list of conditions and 
the following disclaimer. 

 

* Redistributions in binary form must reproduce the above copyright notice, this list of conditions 
and the following disclaimer in the documentation and/or other materials provided with the 
distribution. 
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* Neither the name of ScienceLogic, LLC nor the names of its contributors may be used to endorse 
or promote products derived from this software without specific prior written permission. 

 

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS 
“AS IS” AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT 
LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR 
A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT 
HOLDERS OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, 
SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT 
LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, 
DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY 
THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT 
(INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE 
OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE. 

 

The MIT License (Libxml2) 
Permission is hereby granted, free of charge, to any person obtaining a copy of this software and 
associated documentation files (the “Software”), to deal in the Software without restriction, 
including without limitation the rights to use, copy, modify, merge, publish, distribute, sublicense, 
and/or sell copies of the Software, and to permit persons to whom the Software is furnished to do 
so, subject to the following conditions: 

The above copyright notice and this permission notice shall be included in all copies or substantial 
portions of the Software. 

THE SOFTWARE IS PROVIDED “AS IS”, WITHOUT WARRANTY OF ANY KIND, 
EXPRESS OR IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF 
MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE AND 
NONINFRINGEMENT. IN NO EVENT SHALL THE AUTHORS OR COPYRIGHT HOLDERS 
BE LIABLE FOR ANY CLAIM, DAMAGES OR OTHER LIABILITY, WHETHER IN AN 
ACTION OF CONTRACT, TORT OR OTHERWISE, ARISING FROM, OUT OF OR IN 
CONNECTION WITH THE SOFTWARE OR THE USE OR OTHER DEALINGS IN THE 
SOFTWARE. 

License Agreement (GoAhead) 
THIS LICENSE AGREEMENT IS BETWEEN YOU AND GOAHEAD (BOTH AS DEFINED 
BELOW). THIS AGREEMENT GRANTS YOU ONLY A LIMITED LICENSE TO USE 
GOAHEAD PROPRIETARY COMPUTER SOFTWARE. BY EXECUTING THIS 
AGREEMENT OR USING THE SOFTWARE, YOU CERTIFY THAT YOU WILL USE THE 
SOFTWARE ONLY IN THE MANNER PERMITTED HEREIN. 

1. Definitions. 

“Documentation” means any documentation GoAhead provides with the Original Code. 

“GoAhead” means GoAhead Software, Inc. 

“Agreement” means this document. 

“Modifications” means any addition to or deletion from the substance or structure of either the 
Original Code or any previous Modifications. 

“Original Code” means the source code to GoAhead’s proprietary computer software entitled 
GoAhead WebServer that is provided to You by GoAhead. 
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“You” means an individual or a legal entity exercising rights under, and complying with all of the 
terms of, this license or a future version of this license. For legal entities, “You” includes any 
entity that controls, is controlled by, or is under common control with You. For purposes of this 
definition, “control” means (a) the power, direct or indirect, to cause the direction or management 
of such entity, whether by contract or otherwise, or (b) ownership of fifty percent (50%) or more of 
the outstanding shares or beneficial ownership of such entity. 

“Response Header” means the first portion of the response message output by the GoAhead 
WebServer, containing but not limited to, header fields for date, content-type, server identification 
and cache control. 

“Server Identification Field” means the field in the Response Header which contains the text 
“Server: GoAhead-Webs”. 

2. License. 

Limited Original Code Grant. 

Subject to the terms of this Agreement, GoAhead hereby grants You a worldwide, royalty-free, 
nonexclusive, nontransferable license, without right of sublicense, subject to third party 
intellectual property claims, (a) to use and reproduce the Original Code, (b) to create 
Modifications from the Original Code, and (c) to distribute source code copies of the Original 
Code form solely when embedded in other software (in a manner that does not allow the Original 
Code to be separated) that provides material functionality in addition to the functionality provided 
by the Original Code. 

Binary Code. 

Subject to the terms of this Agreement, GoAhead hereby grants You a worldwide, royalty-free, 
nonexclusive, nontransferable license, without right of sublicense, to copy and distribute binary 
code copies of the Original Code together with Your Modifications in binary code. 

Restrictions on Use. 

You may sublicense third parties to use Your Modifications if You enter into a license agreement 
with such third parties that bind such third parties to all the obligations under this Agreement 
applicable to You and that are otherwise substantially similar in scope and application to this 
Agreement (without limiting the protections afforded to GoAhead). You may not rent, lease, or 
loan the software. 

Documentation. 

Subject to the terms of this Agreement, GoAhead hereby grants You a worldwide, royalty-free, 
nonexclusive, nontransferable license, without right of sublicense, to copy and distribute the 
Documentation in connection with the authorized distribution of the Original Code and 
Modifications. 

Copyright Notice. 

You agree to include copies of the following notice (the “Notice”) regarding proprietary rights in 
all copies of the Original Code and Modifications that You distribute, as follows: (a) embedded in 
the binary code; and (b) on the title pages of all documentation. Furthermore, You agree to use 
commercially reasonable efforts to cause any licensees of your products to embed the Notice in 
object code and on the title pages or relevant documentation. The Notice is as follows: Copyright 
(c) 20XX GoAhead Software, Inc. All Rights Reserved. Unless GoAhead otherwise instructs, the 
year 20xx is to be replaced with the year during which the release of the Original Code containing 
the notice is issued by GoAhead. If this year is not supplied with Documentation, GoAhead will 
supply it upon request. 
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License Back to GoAhead. 

You hereby grant in both source code and binary code to GoAhead a world-wide, royalty-free, 
non-exclusive license to copy, modify, display, use and sublicense any Modifications You make 
that are distributed or planned for distribution. Within 30 days of either such event, You agree to 
ship to GoAhead a file containing the Modifications (in a media to be determined by the parties), 
including any programmers’ notes and other programmers’ materials. Additionally, You will 
provide to GoAhead a complete description of the product, the product code or model number, the 
date on which the product is initially shipped, and a contact name, phone number and e-mail 
address for future correspondence. GoAhead will keep confidential all data specifically marked as 
such. 

3. Terms, Trademards and Brand. 

License and Use. 

GoAhead hereby grants to You a limited world-wide, royalty-free, non-exclusive license to use the 
GoAhead trade names, trademarks, logos, service marks and product designations posted in 
Exhibit A (collectively, the “GoAhead Marks”) in connection with the activities by You under this 
Agreement. Additionally, GoAhead grants You a license under the terms above to such GoAhead 
trademarks as shall be identified at a URL (the “URL”) provided by GoAhead. The use by You of 
GoAhead Marks shall be in accordance with GoAhead’s trademark policies regarding trademark 
usage as established at the Web site designated by the URL, or as otherwise communicated to You 
by GoAhead at its sole discretion. You understand and agree that any use of GoAhead Marks in 
connection with this Agreement shall not create any right, title or interest in or to such GoAhead 
Marks and that all such use and goodwill associated with GoAhead Marks will inure to the benefit 
of GoAhead. 

Promotion by You of GoAhead WebServer Mark. 

In consideration for the licenses granted by GoAhead to You herein, You agree to notify GoAhead 
when You incorporate the GoAhead WebServer in Your product and to inform GoAhead when 
such product begins to ship. You agree to promote the Original Code by prominently and visibly 
displaying a graphic of the GoAhead WebServer mark on the initial Web page of Your product that 
is displayed each time a user connects to it. You also agree that GoAhead may identify your 
company as a user of the GoAhead WebServer by placing your company logo on its Web site. You 
may further promote the Original Code by displaying the GoAhead WebServer mark in marketing 
and promotional materials such as the home page of your Web site or Web pages promoting the 
product. You also agree to use the latest available logo and script code from GoAhead available 
from the official GoAhead download location. 

No Modifications to Server Identification Field. 

You agree not to remove or modify the Server identification Field contained in the Response 
Header as defined in Section 1.7 and 1.8. 

4. Term. 

This Agreement and license are effective from the time You execute this Agreement until this 
Agreement is terminated. You may terminate this Agreement at any time by uninstalling or 
destroying all copies of the Original Code including all binary versions and removing any 
Modifications to the Original Code existing in any products. This Agreement will terminate 
immediately and without further notice if You fail to comply with any provision of this Agreement. 
All restrictions on use, and all other provisions that may reasonably be interpreted to survive 
termination of this Agreement, will survive termination of this Agreement for any reason. Upon 
termination, You agree to uninstall or destroy all copies of the Original Code, Modifications, and 
Documentation. 
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5. Warranty Disclaimers. 

THE ORIGINAL CODE, THE DOCUMENTATION, AND THE MEDIA UPON WHICH THE 
ORIGINAL CODE IS RECORDED (IF ANY) ARE PROVIDED “AS IS” AND WITHOUT 
WARRANTIES OF ANY KIND, EXPRESS, STATUTORY OR IMPLIED, INCLUDING, BUT 
NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY, FITNESS FOR 
A PARTICULAR PURPOSE, TITLE, AND NON-INFRINGEMENT. 

The entire risk as to the quality and performance of the Original Code (including any 
Modifications You make) and the Documentation is with You. Should the Original Code or the 
Documentation prove defective, You (and not GoAhead or its distributors, licensors or dealers) 
assume the entire cost of all necessary servicing or repair. GoAhead does not warrant that the 
functions contained in the Original Code will meet your requirements or operate in the 
combination that You may select for use, that the operation of the Original Code will be 
uninterrupted or error free, or that defects in the Original Code will be corrected. No oral or 
written statement by GoAhead or by a representative of GoAhead shall create a warranty or 
increase the scope of this warranty. 

GOAHEAD DOES NOT WARRANT THE ORIGINAL CODE AGAINST INFRINGEMENT OR 
THE LIKE WITH RESPECT TO ANY COPYRIGHT, PATENT, TRADE SECRET, 
TRADEMARK OR OTHER PROPRIETARY OR INTELLECTUAL PROPERTY RIGHT OF 
ANY THIRD PARTY AND DOES NOT WARRANT THAT THE ORIGINAL CODE DOES NOT 
INCLUDE ANY VIRUS, SOFTWARE ROUTINE OR OTHER SOFTWARE DESIGNED TO 
PERMIT UNAUTHORIZED ACCESS, TO DISABLE, ERASE OR OTHERWISE HARM 
SOFTWARE, HARDWARE OR DATA, OR TO PERFORM ANY OTHER SUCH ACTIONS. 

Any warranties that by law survive the foregoing disclaimers shall terminate 90 days from the date 
You received the Original Code. 

6. Limitation of Liability. 

YOUR SOLE REMEDIES AND GOAHEAD'S ENTIRE LIABILITY ARE SET FORTH ABOVE. 
IN NO EVENT WILL GOAHEAD OR ITS DISTRIBUTORS OR DEALERS BE LIABLE FOR 
DIRECT, INDIRECT, INCIDENTAL OR CONSEQUENTIAL DAMAGES RESULTING FROM 
THE USE OF THE ORIGINAL CODE, THE INABILITY TO USE THE ORIGINAL CODE, OR 
ANY DEFECT IN THE ORIGINAL CODE, INCLUDING ANY LOST PROFITS, EVEN IF 
THEY HAVE BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGE. 

You agree that GoAhead and its distributors and dealers will not be LIABLE for defense or 
indemnity with respect to any claim against You by any third party arising from your possession or 
use of the Original Code or the Documentation. 

In no event will GoAhead’s total liability to You for all damages, losses, and causes of action 
(whether in contract, tort, including negligence, or otherwise) exceed the amount You paid for this 
product. 

SOME STATES DO NOT ALLOW LIMITATIONS ON HOW LONG AN IMPLIED 
WARRANTY LASTS, AND SOME STATES DO NOT ALLOW THE EXCLUSION OR 
LIMITATION OF INCIDENTAL OR CONSEQUENTIAL DAMAGES, SO THE ABOVE 
LIMITATIONS OR EXCLUSIONS MAY NOT APPLY TO YOU. THIS WARRANTY GIVES 
YOU SPECIFIC LEGAL RIGHTS AND YOU MAY HAVE OTHER RIGHTS THAT VARY 
FROM STATE TO STATE. 
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7. Indemnification by You. 

You agree to indemnify and hold GoAhead harmless against any and all claims, losses, damages 
and costs (including legal expenses and reasonable counsel fees) arising out of any claim of a third 
party with respect to the contents of the Your products, and any intellectual property rights or other 
rights or interests related thereto. 

8. High-Risk Activities. 

The Original Code is not fault-tolerant and is not designed, manufactured or intended for use or 
resale as online control equipment in hazardous environments requiring fail-safe performance, 
such as in the operation of nuclear facilities, aircraft navigation or communication systems, air 
traffic control, direct life support machines or weapons systems, in which the failure of the 
Original Code could lead directly to death, personal injury, or severe physical or environmental 
damage. GoAhead and its suppliers specifically disclaim any express or implied warranty of 
fitness for any high-risk uses listed above. 

9. Government Restricted Rights. 

For units of the Department of Defense, use, duplication, or disclosure by the Government is 
subject to restrictions as set forth in subparagraph (c)(1)(ii) of the Rights in Technical Data and 
Computer Software clause at DFARS 252.227-7013. Contractor/manufacturer is GoAhead 
Software, Inc., 10900 N.E. 8th Street, Suite 1200, Bellevue, Washington 98004. 

If the Commercial Computer Software Restricted rights clause at FAR 52.227-19 or its successors 
apply, the Software and Documentation constitute restricted computer software as defined in that 
clause and the Government shall not have the license for published software set forth in 
subparagraph (c)(3) of that clause. 

The Original Code (i) was developed at private expense, and no part of it was developed with 
governmental funds; (ii) is a trade secret of GoAhead (or its licensor(s)) for all purposes of the 
Freedom of Information Act; (iii) is “restricted computer software” subject to limited utilization as 
provided in the contract between the vendor and the governmental entity; and (iv) in all respects is 
proprietary data belonging solely to GoAhead (or its licensor(s)). 

10. Governing Law and Interpretation. 

This Agreement shall be interpreted under and governed by the laws of the State of Washington, 
without regard to its rules governing the conflict of laws. You hereby consent to the exclusive 
jurisdiction of the state and federal courts located in King County, Washington over any disputes 
arising out of related to this Agreement. If any provision of this Agreement is held illegal or 
unenforceable by a court or tribunal of competent jurisdiction, the remaining provisions of this 
Agreement shall remain in effect and the invalid provision deemed modified to the least degree 
necessary to remedy such invalidity. 

11. Entire Agreement. 

This Agreement is the complete agreement between GoAhead and You and supersedes all prior 
agreements, oral or written, with respect to the subject matter hereof. 
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License (OpenSSL) 
This is a copy of the current LICENSE file inside the CVS repository.  

 

LICENSE ISSUES 

============== 

 

The OpenSSL toolkit stays under a dual license, i.e. both the conditions of the OpenSSL License 
and the original SSLeay license apply to the toolkit. 

See below for the actual license texts. Actually both licenses are BSD-style Open Source licenses. 
In case of any license issues related to OpenSSL please contact openssl-core@openssl.org. 

 

OpenSSL License 

--------------- 

 

/* ==================================================================== 

* Copyright (c) 1998-2008 The OpenSSL Project. All rights reserved. 

 

* Redistribution and use in source and binary forms, with or without modification, are permitted 
provided that the following conditions are met: 

1. Redistributions of source code must retain the above copyright notice, this list of conditions 
and the following disclaimer. 

2. Redistributions in binary form must reproduce the above copyright notice, this list of 
conditions and the following disclaimer in the documentation and/or other materials provided 
with the distribution. 

3. All advertising materials mentioning features or use of this software must display the 
following acknowledgment: “This product includes software developed by the OpenSSL 
Project for use in the OpenSSL Toolkit. (http://www.openssl.org/)” 

4. The names “OpenSSL Toolkit” and “OpenSSL Project” must not be used to endorse or 
promote products derived from this software without prior written permission. For written 
permission, please contact openssl-core@openssl.org. 

5. Products derived from this software may not be called “OpenSSL” nor may “OpenSSL” 
appear in their names without prior written permission of the OpenSSL Project. 

6. Redistributions of any form whatsoever must retain the following acknowledgment: “This 
product includes software developed by the OpenSSL Project for use in the OpenSSL Toolkit 
(http://www.openssl.org/)” 
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THIS SOFTWARE IS PROVIDED BY THE OpenSSL PROJECT “AS IS” AND ANY 
EXPRESSED OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE 
IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR 
PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE OpenSSL PROJECT OR ITS 
CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, 
EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, 
PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR 
PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY 
OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING 
NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS 
SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE. 

* ==================================================================== 

 

* This product includes cryptographic software written by Eric Young (eay@cryptsoft.com). This 
product includes software written by Tim Hudson (tjh@cryptsoft.com). 

 

/ 

 

Original SSLeay License 

----------------------- 

 

Copyright (C) 1995-1998 Eric Young (eay@cryptsoft.com) 

All rights reserved. 

 

This package is an SSL implementation written by Eric Young (eay@cryptsoft.com). 

The implementation was written so as to conform with Netscapes SSL. 

 

This library is free for commercial and non-commercial use as long as the following conditions are 
aheared to. The following conditions apply to all code found in this distribution, be it the RC4, 
RSA, lhash, DES, etc., code; not just the SSL code. The SSL documentation included with this 
distribution is covered by the same copyright terms except that the holder is Tim Hudson 
(tjh@cryptsoft.com). 

 

* Copyright remains Eric Young’s, and as such any Copyright notices in the code are not to be 
removed. 

* If this package is used in a product, Eric Young should be given attribution as the author of the 
parts of the library used. 

 

* This can be in the form of a textual message at program startup or in documentation (online or 
textual) provided with the package. 
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* Redistribution and use in source and binary forms, with or without modification, are permitted 
provided that the following conditions are met: 

1. Redistributions of source code must retain the copyright notice, this list of conditions and the 
following disclaimer. 

2. Redistributions in binary form must reproduce the above copyright notice, this list of 
conditions and the following disclaimer in the documentation and/or other materials provided 
with the distribution. 

3. All advertising materials mentioning features or use of this software must display the 
following acknowledgement: “This product includes cryptographic software written by Eric 
Young (eay@cryptsoft.com)”The word “cryptographic” can be left out if the rouines from the 
library being used are not cryptographic related :). 

4. If you include any Windows specific code (or a derivative thereof) from the apps directory 
(application code) you must include an acknowledgement: “This product includes software 
written by Tim Hudson (tjh@cryptsoft.com)” 

 

THIS SOFTWARE IS PROVIDED BY ERIC YOUNG “AS IS” AND ANY EXPRESS OR 
IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED 
WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE 
ARE DISCLAIMED. IN NO EVENT SHALL THE AUTHOR OR CONTRIBUTORS BE 
LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR 
CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF 
SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS 
INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER 
IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR 
OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF 
ADVISED OF THE POSSIBILITY OF SUCH DAMAGE. 

 

* The licence and distribution terms for any publically available version or derivative of this code 
cannot be changed. i.e. this code cannot simply be copied and put under another distribution 
licence [including the GNU Public Licence.] 

/ 
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License (zlib) 

/* zlib.h -- interface of the “zlib” general purpose compression library version 1.2.3, July 18th, 
2005 

 

Copyright (C) 1995-2005 Jean-loup Gailly and Mark Adler 

 

This software is provided “as-is”, without any express or implied warranty. In no event will the 
authors be held liable for any damages arising from the use of this software. 

Permission is granted to anyone to use this software for any purpose, including commercial 
applications, and to alter it and redistribute it freely, subject to the following restrictions: 

1. The origin of this software must not be misrepresented; you must not claim that you wrote the 
original software. If you use this software in a product, an acknowledgment in the product 
documentation would be appreciated but is not required. 

2. Altered source versions must be plainly marked as such, and must not be misrepresented as 
being the original software. 

3. This notice may not be removed or altered from any source distribution. 

 

Jean-loup Gailly jloup@gzip.org 

Mark Adler madler@alumni.caltech.edu 

 

/ 
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